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Introduction

This application note describes the Renesas FreeRTOS™ configuration which is integrated within Smart
Configurator.

FreeRTOS™ configuration feature helps the user save valuable time to create a project by importing
FreeRTOS™ package to Smart Configurator.

The Smart Configurator provides a function to change the setting of the FreeRTOS™ kernel through
graphical user interface (GUI) and code generation tool easily.

Target Devices
RX600 and RX700 Group

References
FreeRTOS™ customization:

https://www.freertos.org/a00110.html

FreeRTOS™ Memory Management:

https://www.freertos.org/a00111.html

Smart Configurator:

https://www.renesas.com/smart-configurator

FreeRTOS™ and FreeRTOS.org™ are trade marks of Amazon Web Services, Inc.
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1. Creating an FreeRTOS(TM) project

FreeRTOS™ project creation is supported in e? studio v7.3 and above.

At the start of project creation, the user would be able to choose the version of Renesas FreeRTOS™ package,
and the selected version will be imported automatically into the project. This makes it easier for the user so
that the user can focus only on FreeRTOS™ configuration and writing application code.

The steps below show how to select RTOS during project creation:

1) Create a new C project in the e? studio.

The Renesas Starter Kit for RX65N is used in this application notes.

Go to [File] > [New] > [C/C++ Project] to start new project generation.

(2)|File | Edit Mavigate

Search  Project

Renesas Views Run  Window Help

Mew

Alt+Shift+N > | g Synergy C/C++ Project

Open File...
[} Open Projects from File System...

I@ C/C++ Project

™ Project..

Close Ctrl+W | [ Other... Ctrl+N
Close All Ctrl+Shift+W [
Figure 1-1 Creating project from File menu
2) Select [Renesas RX] — [Renesas CC-RX C/C++ Executable Project]. Click [Next].
EESTTW W R I
Templates for New C/C++ Project
” - GCC for Renesas RX C/C++ Executable Project
el ax A C/C++ Executable Project for Renesas RX
(2) | using the GCC for Renesas RX Toolchain.
GCC for Renesas RX C/C++ Library Project
o - aC/Ces Library Project for Renesas RX using
the GCC for Renesas RX Toolchain.
Renesas CC-RX C/C++ Executable Project
> A C/C++ Project for Renesas RX using the
Renesas CCRX toolchain.
Renesas CC-RX C/C++ Library Project
ax A C/C++ Library Project for Renesas RX using
the Renesas CCRX toolchain.
@ < Back Next > Eria
Figure 1-2 Creating project
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3) Give an appropriate name to the project, for example, “RTOS". Click [Next].

4)
5)
6)
7

@ | <Back | Net> |  Finish

=] =
New R CC-RX Executable Project —
Mew Renesas CC-Ri¥ Executable Project |
),
)
Project name: IRTOS I
Use default location
Ch\Smart_Configurator_Example Browse
Create Directory for Project
default
Working sets
[ Add project to working sets
Select...

Cancel

Figure 1-3 Creating project
Select “C” as Language.

Select “Renesas CCRX” as Toolchain.
Select the Toolchain Version. e.g. “v3.01.00”
In the RTOS pull down menu, choose ‘FreeRTOS'.

]
New Renesas CC-RX Executable Project —
Select toolchain, device & debug settings
Toolchain Settings
Language: (4) CIC++
Toelchain: lRenesas CCRX J (5)
Toolchain Version: Iv3.01.00 q (6)
RTOS:
(7) (Freerros
Device Settings Configurations
Target Device: | R5F51101AxLM Create Hardware Debug Configuration
Unlock Devices... E1 (RX) w
Endian: | Little - i
[] Create Debug Configuration
Project Type: | Default RX Simulator »
[] Create Release Configuration

Figure 1-4 Creating project
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8) Select your region if the region selection window pops-up.

Mew Renesas CC-RX Executable Project

Select toclchain, device & debug settings

Toolchain Settings

Language: @®C OC++

Toolchain: Renesas CCRX ~
Toolchain Version: |v3.01.00 ~
RTOS: FreeRTOS ~

Idanane Toolchains,
Regicn Setting X

Select your region.

Device Settings

Target Device: | RSF51101AxLM

bug Configuration

Americas e
Endian: | Little Brazil i }
Eurcpe/Middle East/Africa iguration
Project Type: | Default India o

Mainland China/Hong Kong Region ) .
Singapore/South &5outheast Asia/Oceania nfiguration
South Korea

Taiwan Region

Figure 1-5 Region Setting

9) If FreeRTOS™ package has not been downloaded before, a login window will pop up to start the
download of the FreeRTOS™ package. Fill in user's My Renesas username and password and click
[OK] to proceed.

P8 My Renesas

My Renesas

Enter the e-mail address and password that you registered for My Renesas.
They allow you to download documents and software by using Smart Erowser.

Email Address: ||

|
Password: ‘

Create a My Renesas account to use our tool download services, receive Newsletter / Update Notice, and take advantage of our other services.
Click [About My Renesas] to register it.

About My Renesas Cancel

Figure 1-6 Login MyRenesas
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10) Check the box corresponding to the package to download and click [Download] button to start

downloading.
O x®
RTOS Module Download \
[ =
Select the RTOS modules for download I E 5 i
Title Document Mo, Rewv. Issue date Select All
i 7 n’r n’l’

R¥ Family Renesas FreeRTOS ROTAMN430TESO100 Rev.1.00 2019/01/21 Deselect Al
(10)

< >

Module Folder Path:

| C:h\Users\, 0, eclipse\org.eclipse platform_download\RTOS | Browse...

Figure 1-7 RTOS Module Download

11) After downloading, [FreeRTOS] option is enabled.

12) Select Target Device, e.g. "RX600 > RX65N > RX65N - 176pin > R5F565NEDXFC".

13) Ensure [Create Hardware Debug Configuration] is checked. Select emulator, e.g. “E1 RX".
14) Click [Next].

O *®
New Renesas CC-RX Executable Project —

Select toolchain, device & debug settings

Toolchain Settings

Language: ®C DC++
Toolchain: Renesas CCRX w
Toolchain Version: | v3.01.00 ~

wos (1) (s S

Manage Toolchains...
Device Settings (]_2) Configurations

Target Device: I R5F565MEDxFC I Create Hardware Debug Configuration
Unlock Devices... (13) E1 (RX) l ~

[[] Create Debug Configuration

Endian: | Little

Project Type: | Default RX Simulator =

[] Create Release Configuration

(14)
@ <Back | Net> |[ Finish Cancel

Figure 1-8 Creating project
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15) Choose supported FreeRTOS™ version or check for more supported FreeRTOS™ version. Click
[Next].

e} O ¥

Mew Renesas CC-RX Executable Project
Select RTOS version |

RTOS version setting
FreeRTOS_RX w10.0.00 e

Yersion:

Check for more version...

(15)

< Back Mext = Finizh Cancel

Figure 1-9 Creating project

16) [Smart Configurator] is selected by default.

Note: If FIT module has not been downloaded, choose “Download FIT Modules” to download FIT
package.

17) Click [Finish].

] O

New Renesas CC-RX Executable Project
Select Coding Assistant settings

(16)

Use Peripheral Code Generator

Use FIT Module

Download FIT Modules

Smart Configurator is a single User Interface that combines the functionalities of Code Generator and FIT Configurator which
imports, configures and generates different types of drivers and middleware modules.

Smart Configurator encompasses unified clock configuration view, interrupt configuration view and pin configuration view.

Hardware resources conflict in peripheral modules, interrupts and pins cccurred in different types of drivers and middleware

rmodules will be notified.

(Smart Configurator is available only for the supported devices)

® < Back Mext =

... N
User Application g
(+1]
Driver and Middleware %
Driver Code FIT Modules o
Configured in GUI Selected in GUI =
and Generated and Imported UE
o
MCU Hardware g
A
(17)

Cancel

Figure 1-10 Creating project
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2. Configure the FreeRTOS(TM) kernel

1) Smart Configurator perspective will be launched as shown below.

2) In RTOS.scfg panel, FreeRTOS™ package is ready and displayed in Current Configuration in

[Overview] tab.

(1) %k Rrosschg &2
Overview information

- General Information

Clocks

Allow clock configuration

Components
Allow software component selection and configuration

+ Current Configuration

Selected board/device: R3F365MEDxFC (ROM size: 2MB, RAM size: 640KB, Pin count: 176)

Selected components:

[GR=

@

Application under
development

- S ~=—Components
Middleware
Device '-
driver | RTOS
PR - fins

Component Version Configuration
(2) @ FreeRTOS_Kernel 1.00 FreeRTOS_Kernel(used)
[] r_bsp 4,00 r_bsplused)

(Z)IOverviewIBoard Clocks | Components | Pins | Interrupts

Figure 2-1 Smart Configurator perspective with FreeRTOS™

3) In[Components] tab, select [FreeRTOS_kernel] layer in the Components tree at the left panel.

4) The corresponding parameter is displayed in the right panel for users to quickly manage the

FreeRTOS™ kernel setting.

This provides all possible configuration setting options for the FreeRTOS™ kernel.

5) Click on any configurations option setting in the right panel to display its definition as shown in the

picture below.

i RTOS.scfg 52 = O
Software component configuration G &
Componen... =] :’.f:p » Configure

W (4) Property Value &
type filter text v Configurations
# RTOS scheduler Preemptive
v & Startup # ldle hook Enable
v & Generic # Tickhook Enable
W rbsp #
v = RTOS #
v & R_T_OS Kernel # Thefrequency of the RTOS tick interrupt (TickType_t] 1000
(3) w FreeRTOS Kemel # Thesize of the stack used by the idle task (unsigned short ) 140
# Thetotal amount of RAM available in the FreeRT( (size t) (4571024 )
# Themaximum permissible length of name 12
# Usetrace facility Enable
# Use 16bit ticks [] Disable v
< D >
(5) [Macro definition:configUSE_IDLE_HOOK
Enable: use an idle hook.
Disable: omit an idle hook.
3)
Overview |Board ClocksPins Interrupts
Figure 2-2 FreeRTOS_Kernel configuration panel
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6) After configuring the FreeRTOS™ kernel, FreeRTOS™ kernel code or middleware modules can be
generated and imported to the project source folder by clicking the “Code Generation” button

{5 RTOS.scfg 37 = 8
Software component configuration (6) (==]
Compaonen... ERERE Configure

W Property Value ~
type filter text W Configurations
# RTOS scheduler Preemptive
v & Startup # ldie hook Enable
v & Generic # Tick hook Enable
& rbsp #
w (= RTOS #
v e RT_OS Kernel # Thefrequency of the RTOS tick interrupt (TickType_t] 1000
IR # Thesize of the stack used by the idle task (unsigned short ) 140

Figure 2-3 “Code Generation” button

7) Three folders are generated under <ProjectDir>\src folder:

e [FreeRTOS]: Contains the FreeRTOS™ real time kernel source files.

e [frtos_config]: Consists of ‘FreeRTOSConfig.h’. Every FreeRTOS™ application must have a
FreeRTOSConfig.h header file. FreeRTOSConfig.h configures the RTOS kernel to the
application being built (e.g. Semaphores, Timers and Heap Size). It is therefore specific to the
application, not the RTOS.

o [frtos_startup]:
The freertos_start.c file performs the following:
- The “Processing_Before_Start_Kernel()” function which is called by the
“PowerOn_Reset PC()” function initialises Kernel objects and creates the main task.
- Set up Hook functions.
- Configure CMTO as the RTOS system timer.

I Project Explorer i3 = 0

W [=% RTOS
[ Includes
v [ src
I w = FreeRTOS I
v [ Source
= include
= portable
[ croutine.c
@ event_groups.c
[ list.c

[ queuec
[ stream_buffer.c

[ tasks.c
[£] timers.c
=| readme.tut
| ~ (= frtos_config |
FreeRTOSConfig.h
I ~ (= frtos_startup I
l¢ freertos_object_init.c
[ freertos_start.c
freertos_start.h
== smc_gen
[€] RTOS.c
=| RTOS HardwareDebug.launch
{5% RTOS.scfg

Figure 2-4 Project Explorer
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8) Once FreeRTOS™ kernel is configured, the configurator automatically generates the code reflecting
the configuration choices in “<Project folder>/src/frtos_config/ FreeRTOSConfig.h”

&5 Project Explorer i3 = B  {& RIOS.scfg | [h] FreeRTOSConfig.h 52 l = 0
ES|e ~ 2 @® * FreeRTOS Kernel V18.9.8[] ~
c 28
v 1 RTOS [HardwareDebug] 29 © #ifndef FREERTOS_CONFIG_H
[l Includes 30 #define FREERTOS_CONFIG_H
v [ src 31
(= FreeRTOS 32 /* Prevent Renesas headers redefining some stdint.h types. */
« (= frios confia 33 #define _ TYPEDEF__ 1
" 34
[ FreeRTOSConfig:h 36 @® * Application specific definitions.[]
v [= frios_startup a6
[ freertos_object_init.c a7 #define configUSE_PREEMPTION 1
[ freertos_start.c 48 #define configUSE_IDLE_HOOK 1
[A] freertos_starth 49 #define configUSE_TICK_HOOK 1
- 58 #define configCPU_CLOCK_HZ (BSP_ICLK_HZ)
v & smc.gen 51 #define configPERIPHERAL CLOCK HZ (BSP_PCLKB_HZ)
(= general 52 #define configTICK RATE_HZ (( TickType_t ) 1leee)
= r_bsp 53 #define configMINIMAL_STACK_SIZE (( unsigned short ) 148@)
(= r_config 54 #define conTigTOTAL_HEAP_SIZE (( size_t ) ( 45 * 1824 ))
(= r_pincfg 55 #define configMAX_TASK_NAME_LEN (12)
B RT0S, 56 #define configUSE_TRACE_FACILITY 1
. < 57 #define configUSE_16 BIT_TICKS a
E] RTOS HardwareDebug.launch 58 #define configIDLE_SHOULD_YIELD 1
108 RTOS.scfg 59 #define conTigUSE_CO_ROUTINES ] v
. S i i = -
Figure 2-5 FreeRTOSConfig.h
9) The ‘main_task()’ is in <ProjectDir>\src\{ProjName}.c.
e.g. RTOS.c
[g RTOS.c 52 = 3
@* FILE : RTOS.c[]
#include| "FreeRTOS.h"
11 #include| "task.h"
.
LL
13 =~ void main_task(void *pvParameters)
- f
15
16 /* Create all other application tasks here */
13 while(1};
19
28 vTaskDelete(NULL);
21
22 i
Figure 2-6 {ProjName}.c
R20AN0539EJ0100 Rev.1.00 Page 10 of 11

RENESAS



Renesas e? studio

Smart Configurator FreeRTOS™ Configuration

10) Check your board and select the clock setting in the [Clocks] tab.

For example, if ‘Renesas Starter Kit (RSK)' is used, the clock source should be set to ‘Main clock’ and
if the ‘Target Board for RX family’ is used, the clock source should be changed to ‘HOCO clock’ as
shown in the picture below.

Clocks configuration

(11)

on the board
used

| HOCO clock

Frequency: | 16 * | (MHZ)

[ LOCn elack

(10)

VCC 33 W
PLL circuit
Frequency Division:
x1 b
Main clack Frequency Multiplication:
x10.0 ~
(10)
—e
(10)
Sulp-clock
Change “Main ||
Clock” to HOCO
clock depending

SCKCR (FCLK[3:0])

e X1,/ -
SCKCR (ICLK[3:0])
e 3¢1/2 -

SCKCR (PCLKA[Z:0])
3 1/2 -

SCKCR (PCLKB[3:0])

p x1/4 =

SCKCR (PCLKC[3:0])
o /4 s

SCKCR (PCLKD[3:01)
o 3:1/4 -

SCKCR (BCK[3:0])
o :1,/2 v —

SCKCR2 (UCK[3:0])

BCKCR (BCLKDIV)

FlashiF clock (FCLK)

40.0

System clock (ICLK)

80.0

Peripheral module clock (PCLKA)

80.0

Peripheral module clock (PCLKB)

40.0

Peripheral module clock (PCLKC)

40.0

Peripheral module clock (PCLKD)

40.0

External bus clock (BCLK)

80.0

USB dock (UCLK)

CACHCLK

16

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

(MHz)

Overview BoardlCIocksIComponents Pins Interrupts

Figure 2-7 Change Clock Setting

11) Click [Generate Code] button on the top right to save the changes.

12) To build and debug the project, refer to e? studio Getting Started Guide in this link:

https://www.renesas.com/search/keyword-search.html#q=r20ut4374

R20ANO539EJ0100 Rev.1.00
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.

Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to
stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a
humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. Semiconductor devices must be stored and
transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be
grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for

printed circuit boards with mounted semiconductor devices.
Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings
and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not
guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip

power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified.
Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power
supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for

input signal during power-off state as described in your product documentation.
Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the high-
impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated shoot-

through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.
Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait
until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the
reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an

external oscillator while program execution is in progress, wait until the target clock signal is stable.
Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V. (Max.) and Vi
(Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in

the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the

correct operation of the LSI is not guaranteed.
Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The
characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal
memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity
to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.

© 2019 Renesas Electronics Corporation. All rights reserved.



Notice

1.

10.

11.
12.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all
liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each
Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic

appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human
life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea
repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all
liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any
Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas
Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas Electronics
disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are
not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or
damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for
hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for
evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics
product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled
substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and
regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and
regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics
products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

Corporate Headquarters Contact information

TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:
www.renesas.com www.renesas.com/contact/.

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.
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